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Chapter 3
Wortking with Ricoh PhotoStudio ...

This chaprer describes some basic concepts and concerns when working with Ricoh
PhotoStudio, and Ricoh digital cameras.
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B Workihg With Ricoh PhotoStudio and Ricoh Cameras

Working with Colors

Defining colors in Ricoh PhotoStudio

It is imporrant ro understand the concept of color when working with Ricoh PhotoStudio.
This, after all, is an image color processor. It allows you to change, shift, or enhance colors
in your image document and select items in your document based on their color similarity.

To describe coler, we have to consider how the eye perceives color, and how colors are
created. When you perceive color, it is really your brain reacting to the wavelengths of lighe
that reach your eye.

[f all wavelengths of light reach your eye, you perceive the white color. If there is no light,
you percetve black. If some but not all wavelengths of light reach your eye, you will perceive
a parricular color. So then by mixing light in different ways we can create virtually every
colot,

This is how your computer monitor works. By mixing three basic colors (red, green, and
blue) in varying amounts, it can create over millions of different colors.

This is the origin of the RGB mudel for describing color. This model uses three color
channels: red (R), green (G), and blue (B). Every pixel in the image is a mixture of these
three channels.

Each one of these color channcls can have 2 value anywhere from 0 to 255. The value for a
color channel describes the intensity of that color. A value of 0 means thar channel has no
intensity and will have no effect on a pixel’s color, and a value of 255 means that it is ac full
intensity, So, a pixel with the channel values R = 0, G = 255, and B = 0, will appear as light
green; a pixel with the channel values R = 150, G = 0, and B = 150 will be purple, since
purple is the result of mixing of red and blue.

There is anothet popular model for describing colors: the HSV model. Instead of three color
channels, the HSV model describes colors with channels for hue (H), saturation (S), and
brightness (V).

Hue describes colors based on a special color whee! conrtaining all of the colors of the
spectrum, and can have values from 0 to 360. Values for Hue determine the location (in
degrees) where a color is at on the color wheel. All millions of the possible colors can be
somewhere on the wheel.

Sarurarion describes the intensity of the color and can be any number from 0 (very gray) to
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Working With Ricoh PhotoStudio and Ricoh Cameras

255 (very colorful).

Brightness describes the lightness/darkness of the color and has values from 0 (black) o 255
(white).

Many people find the HSY model ta be more intuitive and therefore easier to work with.
Professionals in the graphics and photography industries often prefer to work with HSV
because rhese industries often use this color models. You should try both and see which
Works bes[ for YOU.

Active and alternative color swatches

At the bottom of the Tools Palette, you will see two color squares, one lying on top of the
other. The color swatch on top is the active color swatch. The rools and commands that
utilize color {e.g., Bucket Fill, Paintbrush, Cut) will always use this color as their source. The
color on the bottom is the alternative or alternate color. These two colors are both used by

the Gradient Fill Tool.

Sometimes you will want to quickly toggle between two colors without having to continually
pick colors from the Color Palette or elsewhere. It is very casy to switch the acrive and
alternate colors - just click on the alternare color.

Changing the color of the active swalch

In Ricoh PhotoStudio, there are three ways to select a new color, First, you can simply pick a
color from the Color Palette by clicking on any coloted square. If the Color Palette is not
visible, use the Show Color Palette command from the View menu and ir will appear on the

desktop.

Another way to change the color is to use the Eyedropper tool; click on any color in the
image with this tocl and the active color swarch will become the same color,

Finally, you can use the Color Selection dialog box to pick a new active color. This method
gives you the widest range of pessible colors. To make this dialog box appear, double-click
on the active color swatch.

To change the alternative color double-click the alternate swatch.

(See “Color Swarches” in Chapter 4 for detail on using the Color Selection dialog box).
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Making color-based selections

You can use the Magic Wand Tool to create selecrion areas based on color Similarity or

Threshold.

nrpenRn

When you set the values for Similariry, you are telling the Magic Wand how close to the
color of the selected pixel the other pixels in the selection area should be. The smaller the
similarity value, the smaller the area of selection will likely be.

For example, if you click che Magic Wand on a pixel which has the RGB channel values 50
for red, 60 for green, and 70 for blue, and you set the similarity to 5 for each of the channels,
the magic wand will select only those pixels which have red values that are berween 45 and
55, green between 55 and 65, and blue between 65 and 75. Increasing the similarity values
will make the above intervals larger.

The Threshold option is simpler than this. It picks all of the nearby colors that are in the
same threshold category as the selected color. So if your threshold value is 150 and the color
value is 130, the wand will pick all adjacent colors with values less than 150.

{See “Magic Wand Tool” in Chapter 4 for more information}.
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B Working With Ricoh PhotoStudio and Ricoh Cameras

Image Data Types and Conversions

This section describes the image data types and their conversions that used in Ricoh
PhotoStudio. The data type of an image is important because it determines how many colors
(or gray levels) the image may contain and how the image can be manipulated in: Ricoh

PhotoStudio.

About Image Data Types

Ricoh PhotoStudio can read and creare five different image data types: 24-bit RGB True
Color, 4-bit Indexed 16-Color, 8-bit Indexed 256-Color, 8-bit Grayscale, and 1-bit Black-
and-White. Ricoh PhotoStudio is able to easily convert most data types into others.

There are a couple of general differences berween the data types worth mentioning up front.

The number of bits per pixel differs for the dara types. This number determines the number
of colers or shades that can be represented in the image. The more bits per pixel, the more
memory is necessary for the image, the more information the image file will contain, and the
more realistic it will seem.

Many Ricoh PhotoStudio commands and tools do not work on certain tmage types. For
example, many of the Enhance and Effects commands will not work with 1-bit Black-and-
White and Indexed-Color images.

In general, when you want to edit images you should make sure they are cither RGB True
Color or Grayscale images, because most Ricoh PhotoStudio functions are available when
cditing these twe data types. You can always change them to another form after you finish
editing.

1-Bit Black-and-White Images

Pixels in 1-bit Black-and-White images are either black (0) or white (1). This type of image
uses only ane channel and rakes the least memory.

Several editing commands do not work with this type of image. In fact, none of the effects
commands and only one of the enhance commands can be used with the Black-and-Whice
image type. Some tools and other commands are off-limits as well.

If you wisk to edit a Black-and-White image, try converting it to an 8-bit Grayscale image
first. When you are done editing you can change it back 1o 1-bit Black-and-White.
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If an image is going to be printed or used on a device that has only black-and-white capabili-
ties, you may want to convert it to this data type to get an idea of how it will lock. Of course,
images saved in this dara type use much less memaory than the others.

Black-and-White images can also be used to create masks and stamps. For more informa-
tion, see the reference sections on the Mask menu and the Stamp tool.

8-Bit Grayscal Images

Grayscale is a singlc-channcl dava type. Pixels can have gray values from 0 to 255; the lower

the value, the darker the pixel. Grayscale images have full edicing capabilitics.
Grayscale data type is the best form for editing images with no color.
Indexed 16- and 256-Color Images

Indexed 16-Color (4-bit) and 256-Color (8-bit) images are single-channel image documents,
All of the colors in indexed coler images are in the color table, a special paletie that can have
either 16 {4-bit} or 256 (8-bit) colors. When an indexed-color image is created in Ricoh
PhoroStudio, the program picks the most appropriate colors and makes a color table that will
give the best representation of the original. Indexed images can be edited in a limited number
of ways, but they also take up less disk space and less space in memory.

None of the filters or the effects commands work for indexed-color images. Also, some of
the wols also will not work for this image data type.

Some computer systems can only display 16 or 256 colars. Converting an image to indexed-
color is a good way to preview what an image will look like on devices that support a limited
amount of colors. If an RGB True Color image will be displayed on such a system, it may be
better to cenvert this image to an indexed-color image, because you can conrrol the way that
the system approximates the images” colots. Keep in mind, though, that even when the
system can not show all of the available colors, Ricoh PhotoStudio can still store them in the
image file.

24-Bit RGB True Color Images
RGB True Color image data type contains the maximum amount of information possible for

an image, and allows you to choose from over 16 million different colors. This data type
uses three channels: red, green, and blue. Each channel can have values from 0 {no color) to
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E Working With Ricoh PhotoStudio and Ricoh Cameras

255 (full color). Any Ricoh PhotoStudio command or teol will worle with the RGB True
Color images.

Image type conversion options

Often you will want to convert an image from one data type to another. When you do so,
there arc scveral options that you should understand.

Colors and color palette options

When you convert an RGB True Color image to Indexed-Color image, you will often need
to pick a color or 2 color palette option. There are the major conversion options you may see
in Ricoh PhotoStudio conversion commands:

System and Optimized are frequently options for the color palette. The System option will
use the Windows system palette found in the Windows' Control Panel. An Optimized color
palette creates a color palette by sampling the image for the most used colors.

The 666 and 676 System are two predefined color palettes for 256 color image. The 676-
created palette will contain six reds, seven greens, six blues, and combinatiens of these colors,
while 666 will use six of each color channel and their mixtures.

When you convert a Grayscale image into an Indexed 256-Color image, you will need to
pick from two options: Firelight and Pseudo Color. Firelight will converr the Grayscale
image into an image that looks as if it is lit by firelight. Its color table will contain shades of
red, yellow, and orange. Similarly, Pseudo Color wil: create a color table from shades of blue,
green, yellow, red, white, and blaclk.

Note: Some image data types can not be converted into other data types. If a particular type
of transformarion is not available for an image, the menu item in the Convert menu will be
dimmed.

Dithering options

Converting images to Indexed 16- and 256-Celor or Black-and-Whire images will often
create harsh color changes and eliminate many of the contours in your document. Dithering
is a way of smoothing out these harsh color changes. Essentially, dithering simulates shades
of color or grayness with combinartions of pixels. For example, when converting from
Grayscale to Black-and-White by using dithering, a square of four pixels that has an average
grayness value of 128 would become a square with two black pixels and two white pixels.

Working with Ricoh PhotoS$tudic and Ricoh Cameras 3-7
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B Working With Ricoh PhotoStudio and Ricoh Cameras

There are two main dithering opsions: Partern and Diffusion,

A Pattern dither replaces squarcs of pixels in the image with squares that have representative
configurations of pixels in the allowable colors,

A Diffusion dither converts one pixel ar a time burt transfers the error, or difference, between
the original value of the pixel and the new value to nearby pixels. In other words, it “dif-
fuses” the error throughout the picture. This will make the picture look somewhar grainy.

The table shown below summarizes some of the characreristics of the five data rypes that

Ricoh PhotoStudio works with.

bi Availability of
Dara Type tes # of colors editing Special notes
per pixel or shades commands .
Convert to .
Black-and-White 1 2 very limited Grayscale for
most are
Grayscale 3 256 available supported
data type
limiced Convert to RGB
Index 16-Color 4 16 A True Color for
availability o
most editing
Vimired Convert to RGB
Index 256-Color 8 256 availability True Colo_::f for
most editing
RGB True Color 24 16.7 million most are [[he bese clla‘l:a pe
available for ediring

The data type informarion of the active image is shown on the Starus Line.
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E Working With Ricoh PhotoStudio and Ricoh Cameras

Acquiring, Importing, and Exporting Images

There are several ways to bring images into Ricoh PhoroStudio, and to export them out for
use by other programs,

You can open existing image files of various types by using the Cpen command, or use the
Clipboard and Capture commands to get images from the Windows Clipboard andfor other
Windows applications. You can load images directly from a digital camera. And you can
also use a scanner or other image input device to acquire images from a slide, photo print,
artwork hard copy, or video. After being processed, images can then be saved in one of the
formats provided in Ricoh PhetoStudio and then transferred to other applications and
systern platforms.

Acquiring

Besides fully supporting the Ricoh RIDC-1 and RDC-2 digital cameras for acquiring images,
Ricoh PhotoStudie can directly interface with and control a digital camera, image scanner, or
other inpur device that supports the TWAIN standard. By installing che device driver
provided by the manufacture and selecting this device from the Select Source dialog box, you
give Ricoh PhatoStudio the capability to recognize and receive images from your TWAIN-
compatible device.

Although the options for acquiring an image are varied for different digiral cameras and
scanners, selecting a proper resolution to acquire may be the most imporrant choice. For
scanning, for example, the higher the resolution selected, the better the printing image
quality obtained. However, this is not always true. The printing quality is also determined
by the capability of your printer. And be aware that a higher-resolution image requires more
memory to work with and to store. If the image is just used for screen display, the resolution
may not need to be greater than that of the monitor screen, which is typically from about 70
to 130 dots per inch {dpi).

'To get images from a Twain device, select Acquire in the File menu. For more information,
see the on-line help references for Acquire and Select Source commands.

Importing and exporting images — about file format

Ricoh PhotoeStudio aliows you to open and save image documents in many file formats. A
file format is the way that the information in an image is stored to a computer file. There are

Working with Ricoh PhotoStudio and Ricoh Cameras 3-¢
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several standards that different computer devices and programs use to store image informa-
tion. The file formars supported by Ricoh PhotoStudio represent the most popular formars
in use today and will allow you to transfer image informartion berween Ricoh PhotoStudio
and virtually any other program that you will want to use.

Some file formats may compress files or give you the oprion of compressing your files. There

are basically two different types of compression: lossy and lossless. Using a lossless compres-

sion algorithm such as LZW compression to save your image usually makes the saved file

& | smaller withour any information less. Using a lossy compression may bring you a higher
compression ratio, but it will lose some image information. JPEG compression is a goed
example of lossy compression.

pyoooog

0

The JPEG format is an excellent way to store final images if you wance to save disk space
o A while storing virtually all of the information that uncompressed images have. You can vary
the compression ratio depending on how much image information you can saciifice. The
better quality compressed image you want, the less compression you can get.

If you plan to edit an image later, it is not suggested to store your image in a lossy com-

e ; pressed file format, because some small amount of information may be lost each time you
A save the image. Over the course of many recompressions this may add up to the loss of a lot

of information. Also, compression and decompression takes time, and may be burdensome

on a slow computer.

e
N

4 ; To open or save an imnage document, sclect Open or Save As command from the File menu,
2 and a dialog box with options for file formar will appear. The different file formats sup-
& 1 ported in Ricoh PhotoStudio incdlude BME GIE PCD, PCX, TARGA, TIFE, and JPEG. And
; . more file formats will be added in Ricoh PhotoStudio.
) BMP is the bitmapped file formar chat is widely used in Microsoft Windows and its applica-
4 i tions. A bitmapped file uses a Windows Device Independent Bitmap (DIB} to store the

b dara. These files specify pixel color in a form thar is independent of the way thac a device
L represents color. These files generally have the filename extension “.bmp”.

. i TIFF is the Tagged Image File Format. This format works well for transferring images
& ‘ berween different computers and is widely used in the printing industry. These files are
stored as “.cif”.

GIF is the Graphics Interchange Format developed by Compuserve. This is an excellent
& : format to use for transferring files between different types of compurers or over phone lines,
' because it can minimize transfer time. This format can support up to 8-bit resolution. 24-
Bit RGB Tiue Color images cannot be stored in this format. These files are labeled “.gif”.

nnAnNnAopnApARAN
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PCD is the Photo-CD formar developed by Kodak. Images in this format are usually
compressed in a compact disc and have several different resolutions available. This format is
mainly designed for desktop publishing image transform and can be read (but not saved) in
Ricoh PhotoStudio. Photo-CD files are labeled “.ped”.

PCX is 2 standard formar used by many [BM PC programs. It was specifically designed by
ZSoft for its PC Paintbrush program. Files in this formart are labeled “.pex”.

TARGA is a format developed by TrueVision, a maker of video boards. This formar is used

« ;]

by several painting and image enhancement programs. Its files are stored as “.tga”.

JPEG is an often-used compression format. This is an excellent formar to use when you have
finished editing a picture and wish to store it in a highly-compressed form. Using JPEG
compression may result in the loss of 2 small part of your image information. JPEG files
generally have the extension “jpg”.
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Selecting and Masking Images

About Masks, Marquees, and Selected Areas

The concepr of selecting objects in an image is, along with the concept of defining colors,
one of the most important ideas in image processing. After all, if you are not using the
program to enhance the color and picture quality of your entire image, then you are probably
using it to move or change particular areas.

Tasks like changing the color of the sky, making dramaric silhouettes, or rearranging people
in a portrair are all possible with Ricoh PhotoStudio, but first, you must be able o select
these objects. In this section, we only discuss some basic concepts of selecting,

New Terms

The concept of picking objects or areas centers around several basic terms.

The selected area is the part of the image thac is surrounded by the marquee. The marquee
is the dashed moving line that designates the sclected area. The selected area is the only part
of the image where your edits will have any effect. If there is no selected area, any edits will
have effect on the entire image. The term selection is synonymous with selected area.

The mask is anocther name for the marquee. You can move the mask around in an image to
define an infinite number of selection areas. These areas will have the same shape as the

So we see that a mask is a shape, and a selection is a piece of an image.

What You Can Do

There are several powerful selecting tools and commands in Ricoh PhotoStudie, We will not
try to enumerate all of them here; that task is left for the reference part of Tool and Com-
mand. Here, we merely wish to hint at some of the fun and interesting things that you can
do with the selecting tools and commands.

You can create selections of any shape by using the sclecting tools.
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You can make a selection based on the color of an area, For example, if you want to change
the color of the sky from blue to red, the magic wand tool can select the sky with just one
click.

You can copy a selection from your image onto the clipboard, and then paste it on other
Ricoh PhoteStudio images or on other applications.

Again, these are not all of the things you can do with the selecting and masking functions,
bur hopefully they will give you an inkling of what you can do with Ricoh PhotoStudio. For
more information on making selections, please refer to "Rectangle Select Tool", "Ellipse
Select Tool", "Freehand Select Tool", and "Magic Wand Tool" in Chapter 4, and the on-line
help for the Mask menu.

J—

|
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Working with Adobe Photoshop Plug-In Filters

Ricoh PhotoStudio supports Photoshop Plug-In fleers for image import, export and special
effects. When started, Ricoh PhotoStudie will first scarch all the *.8ba (for import), *.8be
(for export}, and *.8bf (for effecrs) files in its PLUGINS subdirectory, and then the directo-
ries that ate shown in the enuy of the PluginDirl, PluginDir2, and 3 etc. in the
PSTUDIOQ.INI file that is located in the Windows directory. If any these type of files
installed in the PLUGINS directory or identified in the path entry in the PSTUDIO.INT
file, the Import, Export, and Plug-In Filters submenu will appear in the File and Effects
menu respectively, and the filters are listed.

For cxample, if you have Kai's Power Tool special effects filters installed in both of the
CAKPT and CAKPT1 directories and you want Ricoh PhotoStudio support them, you shall
add the following lines in the C:\WINDOWS\PSTUDIO.INI file:

PluginDir1=CAKPT
PluginDir2=CAKPT1

Including the PLUGINS subdirectory, Ricoh PhotoStudio supports up to five direcrories
that contain plug-in filters.

1 3-14 Ricoh PhotoStudio User Manual
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Working with Ricoh Digital Cameras

The Ricoh PhotoStudio is a customized program based on the ArcSoft PhotoStudio v2.0.
While containing all the funetions in the ArcSoft PhotoStudio, two commands are added in
the Ricoh version so thar the functions for downloading images from a Ricoh camera and
uploading images to a Ricoh camera are seamlessly integrated with the existing PhotoStudio
functions. Without leaving Ricoh PhotoStudio, you can now download the photo images
from a Ricoh RDC-1, RDC-2 camera or PC card and save them in a Ricoh PhotoStudio
album, then manipulate, retouch, compaosite, and apply special effects on the images, and
finally ourput the images through a color printer, or save them back 1o the camera or PC
card for furure presentations.

Download images from a Ricoh camera

For downloading images from a Ricoh RDC-1 or RDC-2 camera, you must use the Down-
load From Ricoh Camera command in the File menu. When this command selecied, the
Download Options dialog box appears, which sets options for downloading image files from
a Ricoh digital camera to your PC computer.

T

Ri
i

coh DSC (*.J5j)
13;‘(&% Wf i

Qptiens in the Download Options dialog box:

Source Shows the currently selected modef of Ricoh camera or
PC card drive for downloading images from a list.
Serial Port Shows the currently selected Serial Port that should

connece to the camera. If you are using the RIDC-2
camera, serial port will be auromarically detected.

Add To Album If this button is selected, the downloaded image files
from a camera or PC card will be saved to your
computer hard drive and inserted into a selected album
from the list on its right hand side.

Working with Ricoh PhotoStudio and Ricoh Cameras 3-15




Open Images on Desktop

Save Images As

If this butron is selected, the downloaded image files
from a camera or PC card will be saved to your
computer and then be opened on the Ricoh
PhotoStudio desktop for viewing and editing.

Your images downloaded from a camera or PC card will
be saved to your computer’s hard disk drive in the
selected file format shown on the box. The original file
format for the trmages in the camera is J61, but your can
select a different format from the list box.

Please refer the camera instruction manual for hew to serup the comrmunication berween

camera and computer. When the oprions are set, click OK and then the computer will start
to communicate with the camera or PC card drive. If you choose to download images from
your Ricoh RDC camera, and the communication is created successfully, the Download
From Ricoh Camera dialog box will appear for immediately downloading. If you choose o
downlozd images from your PC card drive, the selected album will appear for inserting
images in the PC card into the album, while copying them to the hard drive.

Options in the Download Frem Ricoh Camera dialog box:

Total Frames

Selected Frames

Current Frame

“<<“and “>>" Butrons

Shows the number of rotal image files conrained in the
camera,

Shows the number of total image files that are selected
for downloading from the Ricoh camera.

Shows the frame number of the current image. This
image will be displayed on the camera LCD screen if
there is one artached.

Instead of the current frame, if you want to see and
download the other images in the camera, dick on the
“<<” (Reverse) or “>>" (Forward) button for the last or
next image frame. If you want to download the current
frame, make sure the Selecr (square} button is checked.

3-16 Ricoh PhotoStudio User Manual
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Select All If this butron is clicked, all images in the camera will be
selected for downloading,.

Select None If this buton is clicked, all images thar have been
selected currently will be unselected for downloading,

To load images from a Ricoh camera:

1. Choose the Download From Ricoh Camera command from the file menu. The Down-
load Options dialog box appears.

2. Choose a camnera model that is connected to your computer from the Source box. And
make sute you connected your camera on a right serial porr,

3. Click on the Add To Album button and select an album from the list box if you want to
insert the downloaded images into an existing album. (If you want to put images in a
new album, select the NEW album from the list.) Otherwise, click on the Open Images
on Deskrop button to open the downloaded files on the deskeap.

4, Selecta file format to save the downloaded images. You can either use the original
camera file format J6I, or others.

5. Click OK to create communication. If the communication is created successfully, the
Downioad From Ricoh Camera dialog box appears. t

6. In the Download From Ricoh Camera dialog box, you may select frames by clicking the
button “<<* (Reverse) or ">>" (forward). Make sure the Selecr (square) button is ‘ ‘
checked if you want to download the current frame. J i

7. Repeat the step 6 if you want to download more images. Or dick the Select All burton if b
you want to download all images. If you want to unselect the currendy selecred images I
for downloading, dick the Select None butron. ‘

8. Click OK to start downloading the selected images.

Uplead images To a Ricoh camera

For uploading image and sound files to a Ricoh camera or PC card, you must use the Upload
To Ricoh Camera command in the File menu. When this command selected, the Upload

Options dialog box appears, which sets options for uploading image files to a Ricoh digital
camera or PC card from your PC compurer.

Options in the Upload Options dialog box:

Destination Shows the currently selected model of Ricch camera or

PC card for uploading from a list.

Shows the currently selected Serial Port should connect
to the camera. If you are using the RDC-2 camera,

serial port will be automatically detected.

Serial Port
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Album

Image Thumbnail

Arttach/Derach Sound

Total Frames

Selected Frames

Shows the selected Ricoh PhoroeStudio image album
from a list of albums. Select the one which contains
your J6I images for upleading to a Ricoh camera.
Shows the current image included in the selected
album. If you want to select it for uploading, make sure
the Select (square) button underneath is checked. If you
want to see the other images in the album, dlick on the
“<<“ (Reverse) or “»>” (forward) button for the last or
next image frame. If you see a speaker on an image
thumbnail, it means there is a sound file attached with
the image.

This butron can be cither "Artach Sound” or "Detach
Sound”. If there is 2 sound file attached with the
current image, the button is "Derach Sound"”: Pressing
this button will separate the sound file from the image
and "Atrach Sound"” appears. If there is no sound file
attached with the current image, the button is "Attach
Sound". Pressing this button will show up a dialog box
for selecting a sound file to atrach wich the current
image and "Detach Sound" appears.

Shows the number of total J6I image files contained in
the currently selected album. Only J6I files can be
uploaded to a Ricoh camera.

Shows the number of rotal J61 image files that are
selected for uploading to the Ricoh camera. The
thumbnail images with the checked Select (square)
burton underneath are counted.
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Save played media file If this button is checked, the played sound or video file
g will be saved to the camera.
F ) Select All If this butron is clicked, all J6I images in the current
1 album will be selected for uploading.
! Select None If this button is clicked, all J6I images in the current

album will be unselecred for uploading,

Play Sound If this button is clicked, the currently selected sound
file will be played.

Play Video If ¢his button is clicked, the currently selected video file
will be played.

To uplead images to a Ricoh camera or PC card:

1. Cheose the Upload re Ricoh Camera command from the file menu. The Upload
Options dialog box appears.

2.  Choose a camera model or PC card that is connected to your computer from the
Destination box. And make sure you connected your camera on a right serial port if you
select a camera for uploading.

3. Click on the Album list box and select the album, which may contain the J61 images for
uploading, from the list.

4. Search all J6I images by clicking the “<<* or “>>” burton and check the Selecr (square)
button to make the current image available for uploading. If you want to upload all the
J6I images in the album, click on the Select All button.

5. Ifyou want to remove the artached sound from the current image, click the "Derach
Sound"” button. If you want to attach a sound file with the current image, you shall click
the "Artach Scund” button and selecr a sound file for attaching.

6. Click OK 1o start uploading. Please refer the camera user’s manual for how to setup the
communication.

Sl T A e
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